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Symbols

The symbols that may be found in this document are defined as follows.

Symbol

Description

&Danger

Indicates a hazardous situation which, if not avoided, will or
could result in serious injury.

mCaution

Indicates a potentially hazardous situation which, if not avoided,
could result in equipment damage, data loss, performance
degradation, or unexpected results.

U_ﬂNote

Provides additional information to emphasize or supplement
important points of the main text.

Safety Instruction

These instructions are intended to ensure that user can use the product correctly to
avoid danger or property loss. The device can only be operated by trained personnel
in accordance with these instructions and local safety regulations.

Laws and Regulations

® The device should be used in compliance with local laws, electrical safety
regulations, and fire prevention regulations.

Transportation

® Keep the device in original or similar packaging while transporting it.

® Do not drop the product or subject it to physical shock. Keep the device away from
magnetic interface.

Electrical Safety

® The device external wiring connected to the hazardous live terminals requires
installation by an instructed person.

® Make sure that the power has been disconnected before you wire, install, or
disassemble the device.

® The device must be connected to an earthed mains socket-outlet.
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® Make sure the plug is properly connected to the power socket.

® |f the device is powered by terminals connected to the power cord, ensure correct
voltage and wiring of the terminals for connection to mains supply.

® DO NOT expose the device to high electromagnetic radiation.

A\ Laser

® Intra-beam viewing of this product is hazardous as laser beam may cause
dizziness, flash blindness and visual afterimage. Avoid visual interruption during
safety-oriented operations.

® The wavelength is 650~660 nm; the maximum output is 7 mW; laser beam
divergence angle is 36x7° (maximum: 40x10°).

® Prevent eyes from direct laser and wear a pair of goggles for your safety. The
operating wavelength of the eyewear should be longer than laser peak wavelength
and its optical density should be higher than OD5+.

® The following warning labels are attached to the laser aperture of the equipment.
An aperture label is affixed close to aperture through which laser radiation is
emitted.

Al

@ Caution! Use of controls or adjustments or performance of procedures other than
those specified herein may result in hazardous radiation exposure.

® The laser radiation emitted from the device can cause eye injuries, burning of skin
or inflammable substances. Prevent eyes from direct laser.

Maintenance
® DO NOT maintain the camera when it is powered on, or it may cause electric shock!

® |f the product does not work properly, please contact your dealer or the nearest
service center. We shall not assume any responsibility for problems caused by
unauthorized repair or maintenance.

® Wipe the device gently with a clean cloth and a small quantity of ethanol, if
necessary.

® |f the equipment is used in a manner not specified by the manufacturer, the
protection provided by the device may be impaired.
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1.Overview

1.1 Description

The 2-color pyrometer (hereinafter referred to as pyrometer or device) is an intelligent
2-color temperature measuring instrument, which can measure the target of medium
and high temperature with high accuracy. The device is often used in various kinds of
industrial sites with high demand for temperature control.

Pyrometer determines the temperature by measuring the energy ratio of two close
and partially overlapped infrared bands. It can meet the requirements for precise
temperature measurement under unstable target conditions (changing emissivity and
target size) in complex environments, such as high humidity and dusty environment.

Pyrometer can be applied in medium and high temperature measurement scenarios,
such as wire rod, hot rolled sheet, cement kilns, heat treatment, inductive heating,
monocrystalline and polycrystalline silicon, etc. It can also be used in super high
temperature measurement of vacuum furnace, graphite furnace, high temperature
furnace and so on.

1.2 Dimensions

The following figure describes the dimensions of the device.

EE Note

For detailed technical data, please refer to the technical specifications of the product.
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Figure 1-1 Dimensions (Unit: mm [inch])

1.3 Basics

1.3.1 Infrared Radiation and Emissivity

The surface of an object emits infrared radiation, the intensity of which varies with
the temperature of the object.

At the same time, according to the material and surface properties, the emitted
radiation is roughly in the wavelength range of 1 to 20 uym. This fixed constant, which
depends on the substance, is called emissivity. The emissivity of an object depends
on the state of the object's surface, for example, the roughness, color, material type,
etc. The amount of radiated energy emitted by an object is affected by the emissivity.
The higher the emissivity, the greater the infrared radiated energy emitted by the
object.

1.3.2 1-Color and 2-Color Mode

The pyrometer supports 1-color and 2-color temperature modes.

The 1-color mode determines the temperature by the radiation energy of a narrow
wavelength range emitted from an object. The pyrometer measures the average
temperature for a small detection area. Thus, the accuracy of measurement is
affected by several factors, such as whether the target emissivity is stable, the
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measurement setting-up and the target is correctly arranged, and other
environmental factors like background radiation. With proper installation and
accessories to prevent the interference from the lens, the influence of external
factors to the accuracy could be reduced.

The 2-color mode determines the temperature by the energy ratio of two wavelength
bands. This mode is less affected by the changing conditions of the target and the
environment. Because the detected energy on both wavelength bands decrease
simultaneously, which does not affect to the energy ratio.

1.3.3 Targets Smaller Than Field of View

When the target size is smaller than the field of view of the pyrometer, or the target
moves within the field of view, such as narrow cable rods or melted glass, the
infrared radiation energy will be reduced. At this point, the 1-color mode cannot
obtain the true target temperature. However, since the energy ratio is unaffected, the
temperature readings in the 2-color mode remain accurate.

EE} Note

The relationship between the target size and the field of view of the device can affect
the actual measurement distance in 1-color mode.
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2. Appearance

2.1 Component

The pyrometer appearance is shown in the figure below.

M72%1.5 Thread

Objective

Button x4 — <8
. /3
Eyeplecew

Screen

Aviation Plug

Figure 2-1 Pyrometer Exterior Components

2.2 Cable

The pyrometer comes with 1 standard cable from the factory, one end of which
connects to the device’s aviation plug, while the other end can be customized for
power connection, temperature and alarm signal transmission, etc.

_|
®
=
o
Aviation Plug -
3 )
Network

Plug
Figure 2-2 Standard Cable

Aviation Plug

Connects to the aviation plug of the pyrometer.
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Network Plug

Connects to a switch or router for power and network supply. PoE powered, DC24 V.

Terminal
Table 2-1 Description of the Terminal Wiring Sequence

Wire

Number

1 2 3 4 5 6 7 8 9 10 11

Specification | DC Power | Analog | Analog | 4~20 | RS-485+ | RS-485- | COM | No. | PNP | GND

24y | 9round output | A
ground
Function Power input Analog output RS-485 Alarm PNP

communication output

® 1&2: connects to power supply for the device, DC24 V.
® 3R&4&5: two analog outputs.

- 483 are selectable analog outputs: 4 mA~20 mA, 0 mA~20 mA,0V~5V,0V~10
V; resolution: 16 bit, accurate to 0.1°C; maximum load for current loop output:
600 Q.

- 485 are fixed analog outputs: 4 mA~20 mA,; resolution: 16 bit, accurate to 0.1°C;
maximum load for current loop output: 600 Q.

® 6&7: RS-485 output, half-duplex, capable of long-range signal transmission.
@ 8&9: alarm output, optocoupler relay, response time<2 ms.
® 10&11: PNP level output, DC24 V.
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3. Installation

3.1 Positioning

3.1.1 Environment

Before determining the installation location of the device, it is necessary to clarify the
ambient temperature, air quality, and electromagnetic interference at the site.

EE Note

For detailed technical data, please refer to the technical specifications of the product.

Ambient Temperature

Under no circumstances should the ambient temperature exceed the maximum
allowable operating temperature of the device. Optional water/air cooled housing can
reduce internal temperature and increase device adaptability.

Air Quality

If the lens is contaminated or obscured, the measurement accuracy of the pyrometer
will also be affected, so the pyrometer should be kept as far as possible away from
the heat source. Direct installation in scenarios such as water vapor and mist should
be avoided. If necessary, install an air purge or a water/air cooled housing to remove
possible contamination.

Electromagnetic Interference

The pyrometer should be installed as far away as possible from potential sources of
electromagnetic interference, such as various motor equipment. The following
measures are recommended to reduce electromagnetic interference:

® All I/0 connections use shielded wiring. For all external wiring, use cable sleeves
for protection. Solid tubes are superior to hoses in noisy environment.

® To avoid ground loops, make sure that the device or the external power supply
terminal connected to the device is grounded at a single point.

EE} Note

If you are unsure about the temperature measurement mode to use, it is
recommended to select installation points that meet the requirements for both 1-
color and 2-color modes. Refer to 4.3.1 Set Thermometry Mode.
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3.1.2 Distance to Object

The distance to the object is equal to the linear distance from the device lens to the
surface of the target being measured.

The actual distance may vary depending on device models. At the same time, due to
the different principles of the 1-color and 2-color mode, the requirements for the
state of the target, as well as the distance to the object, are all different between two
modes.

1-Color mode

In 1-color mode, the focal length of the device lens and the required target size
determine the optimal distance to the object. In order to obtain accurate readings, the
actual measurement distance needs to meet the following requirements: device
minimum focus distance < actual measurement distance < maximum measurement
distance < maximum focus distance.

1. Refer to the specifications of the device for the minimum focus distance.

2. Calculate the maximum measurement distance based on the device optical
resolution and the diameter of the target.

m S

:‘h D#T

Figure 3-1 Optical Resolution (D:S) as Ratio Between Distance (D) and Spot Size (S)

EE Note

D represents the distance to object. S represents the diameter of the target spot size.
D:S represents the fixed optical resolution. Refer to the technical specifications.

For example: spot size S = 10 mm, device D:S = 100:1, then the maximum
measurement distance should be no more than 1000 mm.

3. Adjust the actual distance according to the field of view of the device. The target
spot size must completely fill the entire field of view of the device.

® To avoid incorrect readings during actual installation, it is recommended that the
installation distance be slightly less than the maximum measurement distance to
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ensure that the target can fully cover the field of view, generally 20% greater than
the field of view.

® Turn on the laser aiming light and observe the size of the spot and the target. The
spot coverage can be considered an area of precise temperature measurement at
the current distance.

Incorrect /_

Acceptable 1

Background

Pyrometer

Target greater
than spot size  Target equal smaller

to spot size  than spot size \

Figure 3-2 Device Placement in 1-Color Mode

2-Color mode

In 2-color mode, the device can be installed at a farther distance, without limitations
of the target size and the device's field of view. Please select the actual measurement
distance based on the device's focal distance, and refer to the technical
specifications of the device to acquire device focal distance.

L] Note

The accuracy of the temperature reading will still be affected when the device
receives a signal that is attenuated below the preset threshold. Refer to 4.12.1 Set
Attenuation Filter for attenuation threshold settings.

3.1.3 Viewing Angles

In 1-color mode, it is best for the measurement direction to be perpendicular to the
target, with an allowable angle between the measurement direction and the target
ranging from 30 degrees to 90 degrees.

In 2-color mode, it is best for the measurement direction to be perpendicular to the
target, with an allowable angle between the measurement direction and the target
ranging from 45 degrees to 90 degrees.
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Good

Bad

Figure 3-3 Acceptable Viewing Angles

3.2 Electrical Connection

Connect the electrical connections according to the required functions. Use shielded
cables for the connections, and configure a voltage converter for devices powered by
AC. When the device is used in environments with severe power interference, such as
medium frequency furnaces, high frequency furnaces, and induction heating, avoid
mixing the device's power supply with the power supply for driving. Make sure to use
a clean power supply.

® Choice 1: Use the standard cable, connect one end to the device's aviation plug,
and connect the terminal to the external power supply. For wiring sequence
instructions, please refer to 2.2 Cable.

® Choice 2: Use the standard cable, connect one end to the device's aviation plug,
and connect the network plug to a router or switch to provide PoE power. Refer to
3.5.1 Connect via Network Cable.
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3.3 Aiming and Focusing

Out-of-focus or misaligned targeting can affect the accuracy of temperature
measurements. Before operation, make sure to aim the device at the target area and
adjust the focus for clarity.

EE] Note

® Operation needs to be carried out at the actual installation site to ensure that the
focus state and parameter settings are consistent with actual situations.

® Before operating, connect the cables and power on the device.

® |t is recommended to debug the equipment before installation. Before debugging,
remove any accessories (if any), and check the device's lens, screen, and buttons
for aiming, focusing, and parameter settings.

3.3.1 Aiming
Visible Sighting

The device screen displays a visible picture, allowing direct observation of the target
position.

1. Aim the device at the target and observe the preview on the screen.

2. Move the device till the target is in the green circle (the actual temperature
measurement area) in the center of the preview and aim at the target.

Eyepiece Sighting

The device has a circular eyepiece on the control interface that allows you to observe
the target.

1. Aim the device at the target and observe the target in the eyepiece.

2. Make sure that the image is centered in the middle of the reticle. When viewing
through eyepiece, move the eyes from side to side to make sure the target does
not move out of the reticle.

Laser Sighting

The device supports laser sighting. When the laser is turned on, the visible preview is
off and you can observe a red laser spot in front of the lens, indicating the target
area.

1. Aim the device at the target and observe the laser spot directly.

2. Position the laser light spot just in the center of the target and aim at the target.
The spot area in 1-color mode shall meet the measurement requirements. Refer to
3.1.2 Distance to Object.

10
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3.3.2 Focusing

The device supports two ways of focusing: focusing via object distance and semi-
auto focusing.

Once the target is targeted in visible sighting, refer to 4.7 Set Focus to focus until the
image details are clear.

3.4 Mechanical Accessories

The device has an M72 x 1.5 standard, 23.5 mm long thread on its front end, which
can be installed with optional accessories such as the fixed bracket, adjustable
bracket, air-purge, and water/air cooled housing.

Fixed
Bracket

Air Purge

Water/Air
Cooled
Housing

Adjustable
Bracket

7 Mounting
Nut

Figure 3-4 Mechanical Accessories

11
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3.4.1 Fixed Bracket

The fixed bracket enables the device to be mounted in a fixed location. For a correct
horizontal device orientation, a swivel range within 60° is available.

1. Lock the fixed bracket to the M72 x 1.5 threaded connection on the front of the
pyrometer using the mounting nut.

2. The fixed bracket has one 6.5 mm diameter hole and one 6.5 mm wide waist hole
at the bottom, which can be mounted with the optional bracket.

*@ 72 _

[0 2.83"] 8
[0.31"]
¢ 95
/\ [0 3.74"]

110
[4.33"]
157.5

[6.20"]

\>
l )
130
60 [5.12"]
6.5 t‘;i
[0.26"] u
® 58
[p2.28"]
965 \ J
[0 0.26"] -
Figure 3-5 Dimension of Fixed Bracket (Unit: mm [inch])
3.4.2 Adjustable Bracket

The adjustable bracket enables the device to be mounted in a movable location. For a
correct device orientation, you can pitch and swivel the sighting axis in a range of
about 60° per axis.

12
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Adjustable
Bracket

1/4UNC-20 Screwx2 Fixed Bracket

Figure 3-6 Adjustable Bracket

1. Lock the adjustable bracket and fixed bracket using two 1/4UNC-20 screws.

2. Lock the fixed bracket to the M72 x 1.5 threaded connection on the front of the
pyrometer using the mounting nut.

3. The adjustable bracket has one 6.5 mm diameter hole and two 6.5 mm wide waist
holes at the bottom, which can be mounted with the optional bracket.

60

[2.36"]
3 X 1/4-20UNC o 58 065
[3 9;34"] /7 [¢2.28"] [¢ 0.26"]
8° ij\ 28 I I 3
™ | o 3
140 65
[5.51°] [0.26"]
(7 ' .
4
ok
oo
)

Figure 3-7 Dimension of Adjustable Bracket (Unit: mm [inch])

13
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3.4.3 Air Purge

The air purge is used to remove dust, moisture, water vapor and suspended particles
from the pyrometer lens and can be installed with the fixed-bracket.

1. Lock the purge onto the M72 x 1.5 threaded connection on the front of the
pyrometer.

[1i] Note

The air purge can be used to replace the mounting nut to secure the fixed bracket.

2. Optional bracket can be mounted via the M72 x 1.5 standard, 23.5 mm long
threaded connection at the front of the purge.

3. Connect the external purge device via the purge connection (G1/4 pipe thread).

G1/4 Purge
Connection
M72x1.5
Thread
41.5
[1.63"]
23.5
[0.93"]

50. 9
[2.00"]

M72X1.5

Figure 3-8 Dimension of Air Purge (Unit: mm [inch])

14
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2\ Caution

® When measuring temperature in 1-color mode, the purge must always be supplied
with clean and dry compressed air or nitrogen to avoid contaminating the lens
area.

® Do not purge with cold air at temperatures below 10 °C, and the purge input should
follow the correct pressure flow.

3.4.4 Water/Air Cooled Housing

The water/air cooled housing is used to keep the lens area clean and the interior of
the device at a low operating temperature.

1. Remove the rear cover by loosening the two snaps on the two sides of the rear end
of the housing.

2. Install the device in position along the inner tube of the housing and secure it with
the L-shaped bracket in the inner tube.

3. The housing has four 1/4UNC-20 threaded connections on the bottom bracket,
which can be used with DS-1707ZJ-E model bracket for fixed point mounting.

G1/4 Purge
Connection

o\\i- o
G1/2

i s> Water/Air Inlet

m»“j G1/2 Water/Air Outlet

Bottom Bracket
(1/4UNC-20 Thread x4)

Q

15
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Figure 3-9 Dimension of Water/Air Cooled Housing (Unit: mm [inch])

4. Connect the purge and water/air cooled device via the purge connection, water/air
inlet, and water/air outlet. Self-selected connecting hoses, air compressors, and
water pumps are available. For situations with higher safety requirements or
where water cooling is not suitable, compressed air cooling or vortex coolers can

be used for cooling.

/2N Caution

® When measuring temperature in 1-color mode, the purge must always be supplied
with clean and dry compressed air or nitrogen to avoid contaminating the lens
area.

® Do not purge with cold air at temperatures below 10 °C, and the purge input should
follow the correct pressure flow.

3.5 Computer Connection

For real-time temperature monitoring and remote configuration of the pyrometer via
the client, the device and the computer need to be connected to support the
implementation via the network or RS-485 serial connection.

16
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3.5.1 Connect via Network Cable
1. Connect the pyrometer and the computer to the same network.

® Choice 1: Connect the device and computer to the switch with a network cable.
® Choice 2: Connect the device to the router or switch first with a network cable, and

connect the computer to the same router or switch via Wi-Fi.

Network
Cable

7 +.§ Network
%\ : Cable

Router Switch

\ I@ . %_;ST

= i 2 Network ‘ -
%\ : Cable ‘

Computer

Pyrometer

Figure 3-10 Pyrometer Network Connection

2. Set the computer IP address to be on the same network segment as the
pyrometer.

Set the IP Address:

Using the Windows 10 operating system of the computer as an example, the steps to
set the IP address of the computer are as follows.

Prerequisites: Make sure you have obtained the pyrometer IP address. Refer to 4.8
Set Network . The factory IP address of the device: 192.168.1.64.

17
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EE} Note

Please enter the device IP address in your browser first. If you have normal access to
the device, you can skip the following steps.

1. Open your computer's Control Panel and go to Network and Internet -> Network
and Sharing Center.

2. Select Ethernet -> Properties, and double-click Internet Protocol Version
(TCP/IPv4).

3. Modify the local computer IP address, subnet mask, and default gateway
information. Click OK. Make sure both the device and the computer IP address are
on the same network segment.

Example: If the device IP address is 192.168.1.64, the computer IP address can be
set to any IP address between 192.168.1.2 and 192.168.1.253, except 192.168.1.64.

What to do next: Access the computer client to configure the device. Refer to 5.1
Network Connection for reference.

3.5.2 Connect via RS-485 Serial Port

1. Connect the terminal interface of the device to the USB to RS-485 converter and
connect to the computer via USB. Refer to 2.2 Cable for reference.

[1i] Note

The USB to RS-485 converter is not included in the package. Please purchase it
separately.

2. Set RS-485 parameters for the pyrometer. Refer to 4.9 Set RS-485 for reference.

What to do next: Access the computer client to configure the device. Refer to 5.2
Serial Connection for reference.
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4.Device Operation

Once the device is installed and wired, you can configure thermometry parameters at
the device end.

This chapter describes how to configure the parameters on the device.

4.1 Control Interface

When the device is powered on, the screen shows the live view as the following
figure.

The device supports two modes: visible light live view and temperature display.

You can adjust the settings by key operation. When the settings are adjusted, the
display changes accordingly.

Eyepiece

Back————222=2 g Y aae=—— CoONfirm

Preview

Figure 4-1 Control Interface

4.1.1 Visible Light Interface

The visible light live view interface shows the visible light live view image.
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As Figure 4-1 Control Interface shows, the visible light live view interface is displayed
after the device is first started.

Table 4-1 Visible Light Live View Interface

No. Description

1 System time (factory calibrated).

2 Temperature measurement mode, 1-color or 2-color.

3 Emissivity (shown in1-color) or slope (shown in 2-color).

4 Channel name, which can be modified by web configuration.

5 Temperature value and unit of measured area. Value that is in the

normal range is displayed in green, and value that exceeds the
alarm threshold is displayed as the upper/lower threshold in red.

6 The actual measured area. The size of the circle is influenced by
the optical resolution, and is fixed in the center of the image. The
device measures the temperature in the circle area.

4.1.2 Temperature Display Interface

The temperature display interface shows detailed temperature information, time
functions, and more.

On the visible light live view page, short press A or W to switch to the temperature
display interface, as shown in Figure 4-2 Temperature Display Screen.
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9 1000 = 20ms

Figure 4-2 Temperature Display Screen

Table 4-2 Temperature Display Screen Icons

No.

Description

System time (factory calibrated).

The device IP address, shown as the default address in the figure.

Channel name, which can be modified by web configuration.

AW DN

Temperature value and unit of measured area. Value that is in the
normal range is displayed in green, and value that exceeds the
alarm threshold is displayed in red. When the measured
temperature exceeds the upper/lower temperature range, the
temperarure range is displayed in red.

Device internal temperature value.

Thermometry range.

Thermometry mode, 1-color or 2-color.

Emissivity (shown in 1-color) or slope (shown in 2-color).

O [0 | | O | »n

Special values for time functions. The special values are shown in
the following table for all cases.
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Table 4-3 Special Value of the Time Function

T X. X. X. = X. ms
Fixed | O: 0: 0: Peak | = Output Fixed
value | Averaging | Temperature | hold off time value, the
T. on filter on 1 Peak output
1: 1: hold time unit
Averaging | Temperature | 2. va|ley
Off filter off hold

Oxide scale filter on. * Shown only when oxide scale filter is on.

4.1.3 Operation

Configure the device menu by pressing the buttons.

Table 4-4 Button Description

Button

Description

@

The Confirm button.
In the live view interface, short press to enter the main menu.

At the Menu Setup interface, short press to confirm the current
value.

The Navigate Up button.
In the live view interface, short press to switch the display mode.

In the Menu Setup interface, short press to move up or adjust the
parameters.

The Navigate Down button.
In the live veiw interface, short press to switch the display mode.

In the Menu Setup interface, short press to move down or adjust
the parameters.

The Back button.
In the live veiw interface, long press to lock/wake the device.
* Short press W again to unlock the device after waking it.

On the Menu Setup interface, short press to confirm the setting and
return to the previous menu.
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4.2 Menu Structure

The device main menu is structured as shown below, and you can press ?@\) to
confirm the selection.

Temp. | Time - .| Analog o ol
Settings [ Function [>| Alarm ”| Output » Focus Network
v
— Device |, Advanced| Screen |, -
@ Information[® Settings [© off [° Laser |« RS-485

4.3 Set Thermometry Parameters

Set temperature mode and configure the parameter before measurement.

Enter temperature settings menu:
1. At the live view interface, short press Fd) to enter the main menu.

2. Short press A or ¥ to select Temp. Settings, and short press F@\) to go to the
temperature parameter setup menu.

4.3.1 Set Thermometry Mode
1. In the Temp. Settings menu, short press A or ¥ to select Mode.
2. Short press F@) to switch between 1-Color and 2-Color.

3. Short press O to save the settings and return.
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Table 4-5 1-Color/2-Color Mode Scenarios
1-Color Mode 2-Color Mode

® The working environment has water

® The background temperature is| Vvaporand dust, and the optical lens is

higher than the target temperature. | partially blocked, causing energy

® Optical channel has little dust and degradation.

vapor, and is not obstructed. ® The measured target size and

® The surface of the target is flat and distance will vary.

the physicochemical state is stable | ® The target is changed frequently.

(emissivity is stable). ® The target emissivity is unstable.
® The target size is larger than the | ® Measure small targets at a distance,
device field of view. and the target is smaller than the

device field of view.

4.3.2 Set Emissivity (1-Color)

Every object has its emissivity, and the value varies with object surface material
ranging from rough to smooth. The emissivity of almost all material in practical
applications is less than 1.000. Modify the emissivity of the target on the device to
ensure measurement accuracy.

1. Short press A or ¥ to select Emissivity.

2. Short press &\D to confirm.

3. Short press A or ¥ to adjust the value, and short press F(é to confirm and
move to the next position.

4. Short press O to save and return.

EE Note

In 1-color mode, the target emissivity must be set. For more accurate target
emissivity in 1-color mode, refer to the following methods:
® Use a resistance temperature detector (RTD) or thermocouple to detect the real
temperature of the target and adjust the emissivity until the device displays the
same value as the real temperature of the target.

® |f part of the surface of the target is coated with dark black paint, the emissivity in
1-color mode can reach 0.98. Measure the area adjacent to the object and adjust
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the emissivity until to the same temperature, which is the correct emissivity for
the object.

4.3.3 Set Slope (2-Color)

The emissivity of all real objects changes with wavelength and temperature. The
slope is the ratio of the emissivity in two separate wavelength bands. It is to
compensate for the difference between the emissivity over two wavelength bands.
The factory default values can satisfy most measurements, and adjustments are also
supported.

Slope is only supported in 2-color mode, and the default slope factor can be used.
1. Short press A or ¥ to select Slope.
2. Short press Fd) to confirm.

3. Short press A or ¥ to adjust the value, and short press FG\,) to confirm and
move to the next position.

4. Short press O to save and return.

[1i] Note

® The following 2-color slope values are approximate values and vary with alloy
material and surface finish and application. The data in the table is for reference
only.

Table 4-6 Approximate 2-Color Slope for Some Materials

Material Surface Status Approximate
Slope Factor

Cobalt, Stainless Steel, | Metal oxide surfaces 1.000
Nickel, Iron, Steel

Cobalt, Rhodium, Platinum, | Smooth, clean, non-oxidized | 1.030
Iron, Stainless steel, metal finish

Tungsten, Molybdenum,
Steel, Nickel, Tantalum

Cast iron / 1.000

® |f you need to obtain an unknown 2-color slope for the target, use a reliable
contact thermometer to measure the temperature of the target surface. For
example, measure the temperature of several areas on the target and average the
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values. Adjust the slope until the temperature measured by the device is equal to
the actual temperature of the target.

4.3.4 Set Unit

Set the displayed temperature unit, C for Celsius °C and F for Fahrenheit °F.
1. Short press A or ¥ to select Unit.

2. Short press F@ to switch unit.

3. Short press O to save and return.

4.4 Set Time Function

Set the output time and mode of temperature data. The time function influences the
recording and output of temperature data.

Enter the time function menu:
1. In the live view interface, short press F@\,) to enter the main menu.

2. Short press A or ¥ to select Time Function, and short press F@\) to go to the
time function menu.

4.4.1 Set Output Time

Set the output time interval for the measured data, which means that the device
performs a temperature recording and output the data at intervals.

1. In the Time Function menu, short press A or W to select Output Time.
2. Short press Fd) to go to the setup menu.

3. Short press A or ¥ to adjust the value, and short press FG\,) to confirm and
move to the next position.

4. Short press O to save and return.

4.4.7 Set Averaging

The measured temperature values are averaged over the specified time interval to
obtain a smoother temperature value. For example, if the averaging is set to "3", then
the device calculates the average of the measured values over the three output
times.

This feature is applicable to temperature measurement scenarios where there are
intermittent extremes values. The averaging of temperature values can reduce
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temperature fluctuations, improve result stability and is suitable for most
applications.

1. In the Time Function menu, short press A or W to select Averaging.
2. Short press F(l) to go to the setup menu.
3. Select Enable and short press F@\a to turn on the averaging function.

4. Select Number, short press EG\D to set the value. Short press A or ¥ to adjust
the value, and short press F@) to confirm and move to the next position.

5. Short press O to save and return.

4.4.3 Set Temperature Filter

Set the temperature range of the measurement and the device will not record the
value that is out of the range.

1. In the Time Function menu, short press A or W to select Temperature Filter.
2. Short press Fd) to enter the setup menu.
3. Select Enable and short press EG\D to turn on the filter.

4. Select Max. Temp./Min. Temp. and short press F(l) to set the value. Short press
A or V¥ to adjust the value, and short press &‘a to confirm and move to the
next position.

5. Select Mode, and short press Fd) to switch.

Filter Mode | Description

Reset When the target temperature is higher than the Max.Temp, the
output value is the upper temperature limit (i.e., the Max.Temp).
When the target temperature is lower than the Min.Temp, the
output value is the lower temperature limit (i.e., the Min.Temp).

Hold When the target temperature is out of the set temperature range,
the output temperature remains at the last measured value
that is within the temperature range until a new temperature
value within the temperature range is measured.

6. Short press O to save and return.
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4.4.4 Set Peak/Valley Hold

The output temperature value only selects the highest or lowest measured
temperature. This function is suitable for measuring moving or partially obscured
targets (e.g., a mill steel sheet partially covered with scales).

1. In the Time Function menu, short press A or ¥ to select Peak/Valley Hold.
2. Short press F@ to enter the setup menu.
3. Select Enable and short press EG\') to turn on the peak/valley hold.

4. Select Mode and short press F@\a to switch.

Peak/Valley Hold | Description

Peak Hold Represents the highest measured temperature value.

Peak temperature measurement is suitable for measuring
moving targets: When fast moving targets are measured,
the passing duration through the detection area is short,
e.g., less than 1s, the highest temperature needs to be
measured. More accurate measurements can be obtained
in this way.

Peak Hold can also be used to measure the temperature of
metal solutions or liquids.

Valley Hold Measures the lowest temperature value.

5. Select Hold Cycle, and short press F@\) to set the value. Short press A or ¥ to
adjust the value, and short press F@\) to confirm and move to the next position.

[1i] Note

Hold Cycle: The output time of temperature peak or valley value. For example, if the
hold cycle is set to 3, and the output time is set to 2 ms, the device outputs the
peak/valley value and lasts for 6 ms (Hold Cycle x Output Time).

6. Short press O to save and return.

4.4.5 Set Oxide Scale Filter

Oxidized and non-oxidized metals have different surface properties, which can cause
deviations between the measured temperatures. Enable this function to filter the
oxide scale to improve measurement accuracy and reduce the value fluctuation.

1. In the Time Function menu, short press A or W to select Oxide Scale Filter.
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2. Short press FG\') to turn on the function.

3. Short press O to save and return.

[1i] Note

When Oxide Scale Filter is turned on, parameters associated with functions like
Output Time, Averaging, Temperature Filter and Peak/Valley Hold cannot be
configured, and these parameters stay with default values. When Oxide Scale Filter is
turned off, the above parameters can be configured.

4.5 Set Alarm

The alarm types include high, low, and internal overheat alarms. When the target
temperature or the device internal temperature reaches the threshold, the alarm is
triggered. The alarm appears on the device live view interface, and the temperature
value is highlighted in the alarm color (red).

The device can connect with external alarm modules. You can refer 2.2 Cable for
wiring instructions.

1. In the live view interface, short press F@\) to go to the main menu.

2. Short press A or ¥ to select Alarm, and short press F@) to enter the alarm
setup menu.

3. Select Alarm Status, and short press F@\a to enable this function.

4. Set alarm thresholds according to alarm category.

Alarm Description
Category
Max. Temp. Set Max. Temp. and the alarm is triggered when the target

temperature is greater than or equal to this Max. temp.

Min. Temp. Set Min. Temp. and the alarm is triggered when the target
temperature is less than or equal to this Min. Temp.

Alarm Set Alarm Threshold, and the alarm is triggered when the

Threshold device internal temperature is greater than or equal to this

upper limit. * The device internal temperature can be viewed
on the temperature display interface. The water/air cooled
housing can effectively reduce the internal temperature of the
device.

5. Short press O to save and return.
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4.6 Set Analog Output

The real-time temperature output is achieved through the analog output of the device,
which supports 2 sets of outputs.

Prerequisite: The analog output terminal is connected. Wiring instructions can be
found in 2.2 Cable.

1. In the live view interface, short press F@\a to enter the main menu.

2. Short press A or ¥ to select Analog Output, and short press FG\') to enter the
analog output setup menu.

3. Select Analog Output, and short press F@\) to enable this function.

Analog Output | Description

Analog Output | Fixed current analogue output (4 to 20 mA). You can set the
1 temperature corresponding to the upper and lower limits of
the analog current output. That is, the upper limit of output 1
corresponding to 20 mA, and the lower limit of output 1
corresponding to 4 mA.

Analog Output | Supports different selection of current/voltage analog
2 outputs. You can set the upper/lower limit temperature
corresponding to the upper and lower current output of
analog output 2.

4. Short press O to save and return.

EE} Note

For specific output specifications of the two analog outputs, refer to 2.2 Cable.

4.7 Set Focus

The device can focus on the target by semi-auto focusing and manual focusing.
1. In the live view interface, short press F@\,) to enter the main menu.

2. Short press A or ¥ to select Focus, and short press E@) to enter the focus
setup menu.

3. Select Focus Mode, and short press F@\) to switch.
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Focus mode

Description

Distance: Enter

1. Select Focus Adjustment and short press Fd) to enter the

the object | focus setup menu.
distance to
make the | 2-Short press A or W to adjust the value, short press o
device focus | to confirm and move to the next position to enter the value.
properly. 3. Short press O to confirm.
Result: The interface prompts Focus Succeeded and returns
to the Focus menu.
Semi-Auto: 1. Select Focus Adjustment and short press F@\) to enter the
Focus is | focus setup menu.
performgd 2.Press and hold &\,) to enable semi-auto focus. You can
automatically, .
or can be also adjust focus by press Focus+ or Focus-.

manually fine-
tuned by the
Focus button.

3.When the device focuses properly, short press o to
confirm and return.

4. Short press O to save and return.

4.8 Set Network

The device supports network communication, and can connect to your computer via
serial port. You can configure the functions and monitor the temperature via web or

client, etc.

EE Note

Refer to 3.5.1 Connect via Network Cable for network connection.

1. In the live view interface, short press F@\,) to enter the main menu.

2. Short press A or ¥ to select Network, and short press Fg\,) to enter the
network setup menu.

3. Select Network Parameters, short press @ to set or view parameters.
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Network Description
Parameters
IP View or configure the device default IP address.

Subnet mask | View or configure the default subnet mask.

Gateway View or configure the device gateway address.

MAC View the device MAC address.

4. Short press O to save and return.

4.9 Set RS-485

The device supports RS-485 communication. You can modify device parameter,
record or query data, or configure functions and monitor temperature through RS-485
serial port on client on your computer.

EE} Note

Refer to 2.2 Cable for RS-485 interface and its pin definition.
1. In the live view interface, short press Fd) to enter the main menu.

2. Short press A or ¥ to select RS-485, and short press F@\ to enter the RS-485
setup menu.

3. Select RS-485 parameters, and short press F@\) to set or view the parameter.

RS-485 Parameters | Description

Baud Rate Default value: 9600. The data can be properly transmitted
within the configured baud rate.

Data Bit Default value: 8.

Stop Bit Default value: 1.

Parity Bit Default: Even parity check.

Decoder Type Default: Modbus-RTU.

Address Decoder address, default address: 1. Up to 26 devices

can be connected.

EE} Note

If not necessary, you can keep the RS-485 default settings.
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4. Short press O to save and return.

4.10 Set Laser
You can turn on the laser and aim at the target through the laser light spot.
1. In the live view interface, short press F(:') to enter the main menu.

2. Short press A or W to select Laser, and short press Fd) to enter the laser
setup menu.

3. Short press F@) to select Laser Mode.

Laser mode Description

NC The laser turns off.

NO The laser is always on.

20 Mins The laser is on for 20 minutes, then it is off and turns to NC
mode.

4. Short press O to save and return.

Uﬂ Note

When the laser is turned on, the live view interface is blocked temporarily, and a laser
spot appears in the target area. You can aim the target using the laser spot.

4.11 Set Screen Off

The device screen is locked when it is not operated for a preset screen off time.
1. In the live view interface short press FG\D to enter the main menu.

2. Short press A or ¥ to select Screen Off, and short press F(l) to enter the
screen off setup menu.

3. Select Auto Screen Off and short press Fd) to select time.

4. Short press O to save and return.

EE Note

When the device screen is locked, short press any key to wake the device. Then long
press O and a message to unlock the device prompts up. Short press W to unlock
the device.
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4.12 Set Advanced Settings

You can set ancillary features, including attenuation filter, lens smudge alarm, and
more.

Enter the Advanced Settings menu:

1. In the live view interface, short press Fd') to enter the main menu.

2. Short press A or V 1o select Advanced Settings, and short press F@\) to enter
the Advanced Settings menu.

EE} Note

In advanced settings, attenuation filter and lens smudge alarm can only be enabled in
2-color mode.

4.12.1 Set Attenuation Filter

When the detected energy attenuates to a certain degree, the device cannot
accurately measure the temperature. The attenuation filter function can determine
the attenuation of the energy emitted from the target to the device. When the actual
attenuation exceeds the set threshold, the alarm is triggered, and you can adjustin a
timely manner to ensure measurement accuracy.

1. In the Advanced Settings menu, short press A or W to select Attenuation Filter.
2. Short press F@) to enter the setup menu.
3. Select Status, and short press Fd) to turn on attenuation filter.

4. Select Threshold, and short press F@\) to set threshold. Short press A or ¥ to
adjust the value. Then short press F@\) to confirm and move to the next position.

EE Note

Example: setting the attenuation threshold to "95%" means to allow 95% attenuation
of energy. The alarm is triggered when the target attenuation is greater than 95%, and
the live view interface displays a red warning alert.

5. Short press O to save and return.

EE} Note

The attenuation thresholds for some of the scenarios are listed below as a reference,
which can be adjusted according to the site and target conditions.
® Set the threshold to > 95% when measuring targets whose diameter is below 2
mm. For example, when measuring the temperature of the test rod, the
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temperature of tungsten wire is usually > 1500 °C, and the filament diameter is < 2
mm.

® Set the threshold to 95% when measuring targets whose diameter is between 2 to
10 mm. For example, when measuring fast moving wire in a steel plant, the target
is always shaking.

® Set the threshold to 80% when measuring targets whose diameter is between 30
to 100 mm. For large targets, the threshold can be set to a smaller value to
prevent signal interference from stray light when the target is close to the device.

® Set the threshold to 70% when measuring targets whose diameter is > 100 mm.
For example, when measuring steel plates in steel mill, much stray light is around
the large target.

4.12.2 Set Lens Smudge Alarm

An alarm is triggered when the device lens has an attached object that interferes with
the temperature measurement, and a red alert appears in the live view interface.
Check and clean the smudge such as dirt on the lens promptly.

1. In the Advanced Settings menu, short press A or W to select Lens Smudge
Alarm.

2. Short press FG\') to turn on the function.

3. Short press O to save and return.

4.12.3 Set Digital Zoom

You can adjust the digital zoom of the device by following the steps below.

1. In the live view interface, short press A or ¥ to select Digital Zoom.
2. Short press F@) to switch digital zoom.

3. Short press O to save and return.

4.12.4 Set Device Initialization

You can restore the parameters of the device to factory settings.

£+ Caution
Use this function with caution.

1. In the Advanced Settings menu, short press A or W to select Device
Initialization.

2. Short press F(.\,) to confirm, and a prompt appears.
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3. To confirm the initialization, select OK, otherwise select Cancel.

4.13 View Device Information

You can view device model, serial number and detailed version information, IP
address, and more.

Enter the Device Information menu:
1. In the live view interface, short press F@\a to enter the main menu.

2. Short press A or ¥ to select Device Information, and short press FG\D to enter
the menu and view device information.
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5.Client Operation

With the companion client, you can view real-time image of the device, analyze
temperature curve and configure parameters to assist with temperature data
management.

Download Address:

Please visit our website (www.hikmicrotech.com) or contact our technical staff to
obtain and install HIKMICRO Studio Client (hereinafter referred to as Client) to your
computer.

f
u HIKMICRO Studio

/2\ Caution
To ensure complete function of the client, make sure to install client of V1.2.0 and
above.

Instructions:

The device connects with the client via IP or RS-485 serial port, and the client
supports different configurations depending on the connection method.

- For information about connection over an IP network, refer to 5.1 Network
Connection.

- For information about connection over RS-485 serial port, refer to 5.2 Serial
Connection.

For more information:

Refer to the User Manual embedded in the client (Click the icon E on the top right
corner in the client, and select Help -> User Manual) to obtain detailed instructions.

EE} Note

Due to client upgrade, the functions described in the manual may not be consistent
with actual functions, and actual functions shall prevail.

5.1 Network Connection

You can connect the device to the client via network cable.
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; Configure
Cable. > ﬂ_IACB\Iat_e » Add Device » Live View » Thermometry
Connection e bevice Parameters

5.1.1 Connect Cable

Connect the cable via network interface.

Refer to 3.5.1 Connect via Network Cable to connect your device to your computer
with a network cable, and set the computer and device IP addresses to the same
network segment.

5.1.2 Activate Device

To enhance system and data security, activate the device to initialize the device.

L] Note

Activation via the client is only supported by certain device models. When activating
the device, make sure that the device is online and has not been activated before.

1. Open the client, and select Device Management -> Devices in the Maintenance and
Management area of the home page.

2. Click Online Devices, and click Refresh. Then online devices are displayed in the
list.

3. Select one or multiple devices, and click Activate.

L] Note

If you select multiple devices to activate at the same time, only one window will pop
up. Typically, the account name and password for the selected devices are the same.

4. Enter the IP Login Password and Confirm Password.

/2\ Caution

® To better protect your privacy and improve product security, we strongly
recommend that you set more complex passwords according to the following
rules: Password length must be between 8 and 16 digits, and is combination of
two or more types of numbers, upper and lower case letters or special characters.

® Please understand that it is your responsibility to properly configure all passwords
and security settings of other relevant products.

5. Click OK.
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6. (Optional) In the list of online devices, click to modify device information such
as name, IP address, port number, and so on.

5.1.3 Add Device

Devices can be added to clients in a variety of ways, including via IP/Domain and IP
segment, and online devices searching. After the device is added to the client, you
can configure and manage the device remotely.

Add Online Device Automatically

Clients can automatically detect online devices that are on the same network
segment as the current computer and obtain device-related information such as IP
addresses. With this function, detected online devices can be quickly added to the
client. When detected online devices use the same username and password, multiple
devices can be selected at the same time and added to the client simultaneously.

When you add a device for the first time, refer to 5.1.2 Activate Device. After the
device is activated, click +Add to add device.

Add Device via IP/Domain or IP Segment

After the device is activated, you can add the device to the client by entering
information such as the IP address or domain name.

If the IP addresses of multiple devices to be added range in the same IP segment and
have the same port number, user name, and password, you can add the devices via IP
segments. You can quickly add devices to clients by specifying the starting and
ending IP addresses of the devices.

1. In the Maintenance and Management area of client home page, select Device
Management- > Device.

2. Click +Add to open the device adding interface.
3. Select Add Mode as IP/Domain.

4. Set the parameters in the interface.

39



Pyrometer * User Manual

Parameters Description

Name Depending on the device model or location, you can
customize the name.

Address Device IP address, which can be obtained automatically.

Start/End IP | Set the IP segment.

address

Port The device port number, which is automatically obtained
and allows manual modification.

Username Enter the user name for IP login (not the user name for
client login).

Password Enter the password for the IP login (not the password for
client login).

5. Click Add, and close the interface, or click Add and New to continue adding
additional devices in the interface.

5.1.4 Live View

View real-time visible image and monitor real-time temperature and temperature line
chart.

Once the device is connected to the client, you can view real-time visible image
through the client, keeping up to date with target situation. You can also monitor real-
time temperature of the target and browse dynamic temperature line chart.

1. Click Main View to enter the live view interface.

2. Select the device in the list on the left and turn on the live view by choosing one of
the following three ways.

® Select a camera and drag it to the window.
® Double-click the camera in a group.

® Move your cursor over the camera name, and click .

3. Right-click on the preview window to select the Display Mode, and switch to Live
View Mode or Temperature Mode.

EE} Note

In Temperature Mode, only information, e.g. real-time temperature information, is
displayed, and live view image is not displayed.
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4. Click [™] to hide or display the temperature line chart. When viewing the real-time
image, you can view the real-time temperature line chart for monitoring.

5.1.5 Set Thermometry Parameters

Devices that connect with the client via the network can be configured remotely by
linking with browser.

Choice 1: Configure web parameters via the client

® |n the Maintenance and Management area of the client home page, go to Device
Management -> Devices. In the action bar at the right side of the device list, click
to enter the web configuration page and set thermometry parameters.

® On the client Main View page, select the device and clickn. Click Remote
Configuration to open the web configuration page.

Choice 2: Configure web parameters via device IP

Enters the IP address of the device in web browser, and enter the user name and
password for login.

1. Enter the IP address of the device in the browser, and the login page pops up.
2. Follow the interface prompts to install the plug-in.
3. Open your browser again and enter the IP address of your device.

4. Enter device IP and input the user name and password, and click Login to
configure the parameters in the web page.

EE} Note

When you access the web page through a browser, you can click Help in the upper-
right corner of the web page for detailed instructions on web parameters.

5.2 Serial Connection

Add the device to the client via the RS-485 serial port.

Cable 4| Setting RS-485
Connection "| Parameters

y

Live View

A 4

Add Device

»| Set Thermometry
Parameter

5.2.1 Connect Cable

Use RS-485 serial port for connection.
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Refer to 3.5.2 Connect via RS-485 Serial Port, and connect the device to the computer
via RS-485 cable.

5.2.2 Set RS-485 Parameters

RS-485 can be used to access control signals, and you can configure parameters of
the RS-485 serial port.

Prerequisite: Please make sure that you have configured the RS-485 parameters at
the device end. Refer to 4.9 Set RS-485 for details.

% Caution
The RS-485 parameters on device end and client end need to be the same, otherwise
the client cannot search and add devices for serial access.

1. Start up the client. In the Maintenance and Management area of the home page,
select System Configuration -> RS-485.

2. Set parameters such as baud rate, parity bit, data bit, and stop bit for the selected
serial port.

3. Confirm the decoder type (Modbus-RTU by default).
4. Select the CRC mode.

CRC Mode Description

Big Endian Big-endian stores more significant bytes in the lower
addresses.

Little Endian Little-endian stores low significant bytes in the lower
addresses.

5. Click Save.

6. (Optional) Click Default to restore to default settings.

5.2.3 Add Device

Add the device to the client via the RS-485 serial port.

Prerequisites:

(1) The device has been connected to the computer via RS-485 serial port.

(2) The RS-485 parameters on both the device and the client are configured to the
same.

1. In the Maintenance and Management area, select Device Management -> Devices.
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2. Click +Add to open the device adding interface.
3. Select Adding Mode as RS-485.

4. Click the refresh icon in the upper right corner to display the list of devices that
have been connected to the computer via serial port and that match the RS-485
parameters.

5. Select the device.

6. Click Add, and close the interface, or click Add and New to continue adding
additional devices in the interface.

EE} Note

After the device is connected to the client via RS-485 protocol, modification on the
RS-485 parameters at either device end or at the client end is not supported.

5.2.4 Live View

Once the device is connected to the client, you can monitor the real-time temperature
of the target and view the temperature curve on the client.

Uﬂ Note

Devices that connect to the client via serial ports do not support viewing live view
image on the client, and only temperature values and related parameters can be
obtained.

1. Click Main View to enter the live view page.

2. Select the device in the list on the left and start live view by choosing one of the
following three ways.

® Select a camera and drag it to the window.
® Double-click the camera in a group.

® Move your cursor over the camera name, and click .
3. You can click [™] to hide or display the temperature line chart. When viewing the
real-time image, you can view the real-time temperature line chart for monitoring.

5.2.5 Set Thermometry Parameters

For devices that connect to the client through serial port, you can view and modify
the thermometry parameters in the client and the configuration is saved in the device.

1. Click Main View to enter the live view page.

2. Right-click on the live view window and select Edit Measurement.
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3. Set the thermometry parameters. Refer to 4 Device Operation.

5.3 More Frequently Used Features

Adding a device to the client via network/serial port allows you to remotely manage
the device and perform more functions.

5.3.1 Video and Picture

During live view, you can record videos and capture pictures manually.

[1i] Note

Only devices that connect to the client via network support recording video and
capturing picture.

1. Click Main View to open the live view window.

2. Right-click on the live video and click Start Recording or Capture on the right-click
menu.

Result: When the capture or recording is complete, a prompt message appears in the
lower right corner of the screen, showing the file storage path. You can go to the local
folder to view the file.

3. (Optional) Go to Maintenance and Management -> System Configuration -> File to
set file storage path.

EE Note

Capturing raw image and recording raw video are not supported with clients of V1.2.0
and above.

5.3.2 Searching History Temperature

After saving real-time thermometry data to client database, you can query history
temperature based on time, visualize results displayed in the form of temperature
curve, and export results.

1. In the Maintenance and Management area of the home page, select System
Configuration -> General.

2. Check Save Temperature Data and set storage parameters.
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Parameters Description

Save Data For The time for keeping the data. Once storage duration
expires, the data will be deleted.

Temperature Auto- | The tempearture data is saved automatically according
Save Interval to the storage interval.

3. Click Save.

4. On the home page, select Search History Temp. Set searching criteria, and then
click Search to display temperature report on the right.

5. (Optional) Click Export to export temperature data, or click Export Original Record
to export raw temperature data.

EE Note

Refer to the User Manual in the client (Start up the client, and click E on the top
right corner. Then select Help -> User Manual) to get detailed instructions for more
features.
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6. Troubleshooting

During operation or operation of the device, if special conditions occur, perform self-
test troubleshooting in the following directions, if the problem is not resolved
properly. Please contact our technical staff.

Special cases | Possible causes Resolution

No image input | The device is not properly | Check that the power supply wiring
plugged into power. or PoE supply is OK.

Incorrect Incorrect wiring. Check and confirm wiring.
temperature
measurement
results

Incorrect The picture is masked. Clean out obstructions.
temperature
measurement
results

Incorrect The lens is dirty. Clean the lens.
temperature
measurement
results

Incorrect Incorrect emissivity or slope | Check and reset the pyrometer
temperature parameter setting. temperature parameters.
measurement
results
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